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HOUSEKEEPING

¢ Introductions
e Pen/pencil & paper
e Distractions
— Cell phone
— Pets
— Other household members
e Questions — “Raise Hand”
¢ Breaks
e If we lose Internet connection
e Course Credit

e 2019

EDITION

FOLLOWING

WHAT WAS

LEARN HOW i
TO READ AND pCAL:
FoLLOW

INSTRUCT/ONS
OF ALL KINDS!

(S
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€

Agenda

¢ Packet Update

e October Exercise and SET

e October Exercise Packet Operations
¢ Net Control Updates

e Message Passing

e BBS, Network Update

¢ New FCC Station Evaluations

e Volunteer Hours Reporting

e 2022 Training

e Credential Program

Copyright© 2021 Santa Clara County ARES/RACES. All Rights Reserved.
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Packet Update

Jim Oberhofer, KN6PE
Revised 01-Dec-2021

Packet Exercise

Copyright© 2021 Santa Clara County ARES/RACES. All Rights Reserved.
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Weekly Packet “Practice”

2021... by the numbers (7-Dec-2020 thru 30-Nov-2021)

Ttl Practice Messages sent 1365 1861 3226 3138 2844 2116

% Correct all the time 96.8%  96.5% 96.6%  95.5% 93.7% 93.2%

Unique Ave # of

31 29 255
Participants/Night 2L = el

12/11/2021
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Weekly Packet “Practice”

e See the “Standard Packet Check-In/Out Message” App Note
under...
https://www.scc-ares-races.org/data/packet/index.html#app-notes

e See the Practice Message, Subject section under...
https://www.scc-ares-races.org/data/packet/weekly-packet-
practice.html#Message
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What’s new with
Outpost and PackltForms

What’s in the box?

e SCCo Integrated Packet Installer 160

e QOutpost Packet Message Manager
— GUI-based interface for managing packet communications
— Makes using packet as simple as using e-mail

¢ PackltForms
— Next generation HTML-based forms for use with Outpost
— Headless Chrome for auto-printing support

e PacFORMS
— HTML-based forms for use with Outpost

— Since 2007, simplified forms-based data entry, reduced network
bandwidth

Copyright© 2021 Santa Clara County ARES/RACES. All Rights Reserved.
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SCCo Installer v160
July 2021

PackltForm 3.2.1*
« Digitally signed PackltForm installer and programs
» No functionality changes

Outpost v3.5.0*

» Digitally signed Outpost installer and programs

» Minor functionality changes to address SCC
defects

What was new, differentin 20217

*See the release notes for details

11 12
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Top 7 packet “what’s new” items for 2021

Packet Training on Zoom

Windows 11

Event Documentation

Check-in, Check-out messages
Resend Options (and the Subject Line)
Manual Packet (and the Subject Line)
Packet as a repeatable process

BN W R Uo N

7. Another year on Zoom
Packet training in pajamas

e Ran all the packet classes by zoom
e Zoom registration helped track who actually showed up

e Office Hours offered a chance for troubleshooting, 1-on-1 chats, and
general Q&A

e Updated homework assignments
e Completing the homework was prerequisite for class credit

— Packet IlIA; Outpost and PackltForms 79%
— Packet I1IB; Applying packet to the Field 94%
— Packet Il; What!? No Outpost? Manual Packet 68%

7

13 14
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6. Windows 11

e Windows 11 was released on October 5, 2021
— Price: Free upgrade for existing Windows 10 users
— new desktop look, a major Ul redesign, changes to the core Microsoft
OS apps and services.
— Microsoft says Windows 11 was built for gamers.

e But... not every Windows 10 PC is Windows 11 compatible

¢ The good news: PackltForms and Outpost works fine on W11
e SCC RACES packet PC recommendation:

— Laptop or larger netbook running at least Windows 8.1
(end of W8.1 extended support... January 10, 2023)

15

SIie
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5. Event documentation
Its all about the money FEMA

e Excerpts from the FEMA | Office of Inspector General report titled “Summary of
Key Findings of Fiscal Year 2016 FEMA Disaster Grant and Audits”

* “Over the 7-year period, FYs 2009 to 2015, we found $1.64 billion, or 15 percent, in
questioned costs out of the $10.9 billion that we audited, which we recommended FEMA
disallow as ineligible and unsupported costs.”

* “In fiscal year 2016, we found $155.6 million, or 23 percent, in questioned costs out of the
S$686 million that we audited, which we recommended FEMA disallow as ineligible and
unsupported costs.”

® In cases where FEMA payments were made and claims later disallowed, recipients
would be required to repay these payments, with audits sometimes taking place
years later.

e Because your documentation could be a used as part of the City’s justification for
either an expense reimbursement or cost recovery request, ensuring the accuracy
and completeness of what we submit is critical.

16
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5. Event documentation
Its all about the money

FEMA

e Excerpts from the FEMA | Office of Inspector General report titled “Summary of
Key Findings of Fiscal Year 2016 FEMA Disaster Grant and Audits”
* “Over the 7-year period, FYs 2009 to 2015, we found $1.64 billion, or 15 percent, in

questioned costs out of the $10.9 billion that we audited, which we recommended FEMA
disallow as ineligible and unsupported costs.”

* “In fiscal year 2016, we found $155.6 million, or 23 percent, in questioned costs out of the
5686 million that we audited, which we recommended FEMA disallow as ineligible and
unsupported costs.”

¢ In cases where FEMA payments were made and claims later disallowed, recipients
would be required to repay these payments, with audits sometimes taking place
years later.

e Because your documentation could be a used as part of the City’s justification for
either an expense reimbursement or cost recovery request, ensuring the accuracy
and completeness of what we submit is critical.

How does this apply to us?

« If tracked properly, hours worked volunteering can be reimbursed by FEMA
under the guidelines for “volunteer labor” (44 Code of Federal Regulations (CFR)
13.24 (c) (1)).

¢ The reimbursement rate would depend on the volunteer and the type of work
completed.

*  The reimbursement rate could be in the range of $20 to $50 / hr (estimate)

¢ Forinstance:

Your_ARES 10 10 # volunteers

Hrs / day 12 120 Volunteer hours / day
Days / event 10 1200 Volunteer hours / event
$/hr $35 $42,000 Reimbursement

¢ And... city staff hours are reimbursable if overtime is extraordinary or the work is
not normally budgeted in their job.

* BUT, it all depends on getting the documentation right.

17
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What can go wrong... a case in point

From May 1 through May 2, 2010, Tennessee experienced high winds
and flooding which resulted in widespread loss of power.

The disaster forced residents to vacate their homes and to require food
and basic housing.

The Applicant opened a disaster recovery center and staffed it with
volunteers.

The Applicant requested credit toward the calculation of the non-
Federal cost share for volunteer labor, donated equipment, and
donated materials.

FEMA initially granted Applicant’s request for a $65,416 credit but later
de-obligated $57,714 because volunteer hours were not properly
documented.

Archiving event documentation
Introduction

e During a Packet Deployment, you will produce the following:

1. ICS 214-SCCo Unit Activity Log
ICS 309-SCCo Communications Log (if participating on a voice net)
All third party sent & received PackltForms and plain text messages
All sent and received operator to operator packet messages
ICS 309 Communications Log (packet)

o v A WD

Any Form 1 / hand-scribbled / sticky notes, documentation.

o Applies to exercises and real activations

e When your shift is over, your supervisor will tell you what to do, such as:
— Submitting all documentation (to whom and how)
— Preparing the packet station for the next use (archiving your shift)

19

20
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Event documentation
Introduction

¢ The job is not done until the paperwork
is complete, archived, and submitted.

— Every scrap of paper used during an activation is part of the event or
incident and goes to the Documentation Unit (or your Supervisor)

¢ |t must be legible (print)
e Use one side only
— These are legal documents that may be needed to defend decisions
— Most of this documentation is ‘discoverable’
— Ifitis notin the documentation, then it did not happen
— Some documentation is specifically created after the event or
incident, such as the After Action Report

¢ And, all this applies to our packet operations

Archiving event documentation

1. Create the ICS 309 Communication

Log

a)
b)

c)

Outpost, Forms > ICS 309 Comm Log.

Select Period Tab, then Range for when
your shift (or event) occurred.

Select Output Tab, then which printer

NOTE: If you do not have a printer, then select
the Microsoft Print to PDF printer to produce a
.pdf file.

Press Build Data Set, then press Print.

If you paper-print this form, then sign the
ICS 309.

Deliver this report to your supervisor.

ICS 309

COMMUNICATIONS LOG

=0
cup-18.00T
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message.

d

—~

2. Create a printable message listing
a) From Outpost, File > Save All.

b) Creates an Ascii-formatted file
of all messages in the current folder
with a Page Break between each

c) Repeat for any other folder where
event messages were stored.

This file could be printed to generate
one message per page or cut-n-paste
out a specific message.

e) Deliver this file to your supervisor.

From: kj6oht@wixsc.ampr.org
To: CUPEQC

Sent: 11/20/2021 09:10

e N, ot

Archiving event documentation

Ml Printable Message Listing2.bet - Notepad

File Edit Format View Help

started =

to smell gas outside my house and\nthink it i%
hous=

e. -- People Trapped: negative\nLast Seen:n/a
DEVD=KJ60HT

DATM=211120 0849

EVNT=BVD21324.,102

!/ADDON! 4

From: kj6oht@wixsc.ampr.org
o CUPEQC; KJG6OHT

Sent: 11/20/2021 @9:01

Subject: OHT-225P_R_Downed Tree KJGOHT BVD

The earthquake brought down a tree at the end
blocking the road. Cars cannot pass. Some nei
clear it.

Location: @ Puddling Stoen Way, Cupertino, crof
pacifica.
Reported by: Lou Grant, 21603 La Playa Ct, 46\4

12/11/2021

23

Archiving event documentation

3. Create a Message Archive

a)

d)

e

From Outpost, File > Export, then
select “All Folders* (for your entire
system).

Use meaningful file names.

The Export process will create an
Outpost Archive File (.oaf).

This file later can be imported back
into Outpost to restore the archived
messages to their original folders.

Deliver this file to your supervisor.

B Outpost Packet Message Manager

Print.. CtrleP

Print, No Headers...

Print Setup
P e

New Message CtreN
Save As. Cirle§
Save As, No Headers...

Save All...

Export 5
Import

Move to Folder... »
Copy to Folder... >

Delete All Messages

File Edit Setup Tools Forms Actions Help

Print SendReceive | Prof

This Folder.

[ prITUs@ Wz ——WaxSC-1
knpe@wi.. WIXSC
KNGPE WIXSC
KNGPE WIXSC
ALL K6FB-2

ALL

K6FB-2

-1
-1

-1

24
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Archiving event documentation

4. Reset Outpost for the next event
a) You are about to DELETE ALL MESSAGES in Outpost

m Do not proceed until you have created a
Message Archive>All Folders first.

Do not proceed until you have
permission from your supervisor.

b) Make sure you set up the SCC Notices message folder

c) Export (backup) the SCC Notices folder (File > Export...)

c) Delete all Outpost messages (File > Delete All Messages, Yes)
d) Restore the SCC Notices (File > Import...)

e) You now have a clean system for the next event or incident.

f) Inform your supervisor that this task is complete.

e

iy

4. Check-In/-Out Messages

¢ Properly formatted Check-In/Out messages are important
— Recipient can easily find them among other messages in the In Tray
— They inform the EOC or other “net control” which stations are ready
— They are part of DSW supervision

/K‘_General rules during field assignments

7 - Checkinand out using your assigned Tactical Call, not your FCC call

— Check-in as soon as the station is ready
— Check-out before shutting down the station using your Tactical Call
— Always send as plain text messages (not forms)
— Always use [HandlingOrder] =“_R_"
¢ Handling Order = R (Routine)
— Always follow the standard subject line format ;
e With specific check-in/out details for subject and message body z

25

26
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Check-In/-Out: Tactical

e Tactical Check-In Format:

— Subject: [MsgNbr]_R_Check-In [TacticalCallSign], [TacticalName]
— Body: Check-in [TacticalCallSign], [TacticalName]

Present are:

[List of FCC call signs and full names, one per line]

e Example:

— Subject: SH1-234P_R_Check-In XNDSH1, Xanadu Shelter 1
— Body: Check-in XNDSH1, Xanadu Shelter 1

Present are:

W6XRL4, Herman Munster

e Check-Out format is the same, except replace “Check-In” with “Check-Out”

https://www.scc-ares-races.org > Data Networking > Packet BBS > Standard Packet Check-In/Out Message

Check-In/-Out: Individual

e Unless your local jurisdiction requires it, it is unlikely you will
need to use an individual check-in/out. But, if you do...

¢ Individual Check-In Format:
— Subject: [MsgNbr]_R_Check-In [FCCCallSign], [FullName]
— Body: Check-in [FCCCallSign], [FullName]

e Example:
— Subject: XRL-123P_R_Check-In W6XRL4, Herman Munster
— Body: Check-in W6XRL4, Herman Munster

¢ Check-Out format is the same, except replace “Check-In" with
“Check-Out”

27 28
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3. Message Resend

You did what?!!?

¢ You just sent a message, but ...
— it was addressed incorrectly, or

it was sent to the wrong BBS, or

you forgot to include all recipients, or

it was incomplete, or

it was the wrong message, or
— any number of other problems!
And, you don’t want to type it all back in! What now?

Resend Options (and the Subject Line)

e Three types of Message Resend
1. Text Message, same Message ID or new Message ID
2. PackltForm Message , same Message ID
3. PackltForm Message , different Message ID

29 30

Copyright© 2021 Santa Clara County ARES/RACES. All Rights Reserved.
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Resend option — Text Messages Resend option — PackltForm Messages
Same Message ID...

BB 6PE-1754 - outpostpm test (PM:1849)

File Edit View Actions Windews Help

Forms Actions Help

. Print | Reply Reply Close . nd/Receive =
Resend a message previously PrteMessage)  Meph o T Resending PackitForm Messages b e
Forward .
sent. e PO s depends on your option. Recche Ony o
: S — i i A s
e Sent folder, open the message — S New Message D « Sent folder, single-click on the message i g::::::‘::m D
e Actions > Resend... choose R = to highlight it (not open it) K Open envancazmag st sl
option [ CUP-280R_R_Check-out CUPEOC, Cupertino EOC - Packet Messag . —d—Force enetime bulletinsettiers____ Qe -LI31E 8

. s 1 RPF.-173
Actions > Open enhanced msg as text Submit to Outpost | Submit via Email|  Reset Form|

e Editthe message. File Edit Actions Window Help Popup Menu
Sanﬂl Print | Save | Delete Clnse[ Urg | Pwt

Once the text opens, click on Actions >

e For Resend, Same Msg ID, 1 Resend... choose Same Message ID Santa Clara County EOC Resource Re

manually change the Message ID

Private Message

e PackItForm opens a new copy in the Message Numbers: | Origin: CP-312
8 %
from -###P to -###R for Resend. Ry o Y Date: 11/2/2021 | Time: 09:17
= SR From: [CUPEOC Browser, ready for editing. ICS Position: Logistics
e Make whatever other changes To.. [[XsCEOC M v ch he M D e
. ocation: |SCC Ef
you need to make, then Subject: [CUP-280R_R_Check-out CUPEQC, Cupertino EOC anually change the Message ID from o e
. -H#H#H#HP to -###R for Resend. :
e Press Send, then Send/Receive. Check-out CUPEOC, Cupertino EOC —_— Contact Info:
Present are: ¢ Make other changes and continue as 1. Incident Name
ENEPE Jim Oberhofez] usual Earthquake, Day 2

5. Requested by (name, agency, position, email, phone)

Copyright © 2021 Santa Clara County ARES®/RACES. All rights reserved

31 32
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Resend option — PackltForm
New Message ID...

e Get the Next Message Number:
— In Outpost, Tools > Report Settings
— Note the Next Message value. This is
the number to use. Do not change it!

Sent folder, single-click on the message to
highlight it (not open it)

Actions > Open enhanced msg as text

Once the text opens, click on Actions >
Resend... choose New Message ID

The PackltForm will open in the browser.

Manually change the PackltForm Origin
message number with the number you
noted above.

¢ Make other changes and continue as usual.

"W 1
Submit to Outpost| Submit via Email|  Reset Form | 1

Messages

B Repon Setings

Variables | Reports | 1C5 309 |

Global Variables

Ned I [3z1 Ifependent of profile setings

Report Variables, this profile

Organization: [Cupenting Citizens Corps ]

ciy. [City of Cupertino

Santa Clara County EOC Resource Re
Message Numbers: Origin: CUP-321P

Date: (VTR |
ICS Position: DEC
T Location: scc OEC

Time: 89:17 Handling

O Name:
Contact Info:

1. Incident Name
Earthquake, Day 2

5. Requested by (name, agency, position, email, phone)

33

12/11/2021

2. Manual Packet (and the Subject Line)

e Without Outpost, you have to manual
Message ID tracking. One method:

e Any piece of paper will do.
e C(Create a list of message IDs to use.

— Use the ‘M’ suffix to indicate this is
———
a Manual message and not conflict
with Outpost’s ‘P’ (for packet) suffix.
¢ When you use one, cross it out.

« Example: given this list, your next
Message ID is X14-303M.

» For packet messages sent or received,

enter the Message ID in the next
message; don't forget your ICS 309.

Xanadu Fire Station 14
Manual Message ID List
Herman Munster, W6XRL4

30—
30244
X14-303M
X14-304M
X14-305M
X14-306M
X14-307M
X14-308M
X14-309M

34
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1. Packet as a repeatable process

¢ Packet 3A — Packet systems and tools
— Packet Network Overview and Components
— Packet Station HW & SW

Accessing the network

Standard workflow

— Working with messages

e Packet 3B — Applying packet to a field deployment
— Customizing message handling
— Miscellaneous Outpost settings
— Localizing packet
— Simulated field message exchange

* Packet 2 — Advanced Packet
— Manual packet messaging

Thinking in terms of a Packet Field Deployment

1. First Shift... when assigned to start up a station

2. Initial station setup... equipment check-out

3. Packet Operations... managing the message flow

4. Incoming Shift Change... if you are relieving someone else
5. Outgoing Shift Change... if you are being relieved

6. Securing Operations... when directed to shut down

35 36

Copyright© 2021 Santa Clara County ARES/RACES. All Rights Reserved.
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1. First Shift
Packet Field Deployment Process

1. First Shift: Establishing a packet station
1.

Inform Resource Net Control that you have arrived. Check out of
the Resource Net before you leave your car.

Check into the assigned voice net before you leave your car.
Start an ICS 309 Comm Log for the voice net.

Make an ICS 214 Unit log entry.
Sign in on the site’s ICS 211 Check-in sheet.
Find the supervisor and inform them of your arrival.

Request a safety and assignment briefing; get details on any site-
or event-specific conditions that exist. You need to know:

Band and frequency
Primary and secondary packet addresses for any
preferred destinations

Find and establish the workspace to set up packet operations.

a. Supervisor's Name

b. Activation Number

c. Operational Period

d. ICS Location

e. Your Tactical Call and Message |ID Prefix
f. BBStouse

g.

h.

12/11/2021

37

2. Initial setup
Packet Field Deployment Process

2. Initial setup: Equipment check-out

v

v

8.

9.

10.

11

Find, assess, and setup the packet radio equipment

(see Section 3, Packet Startup Procedure)

Confirm or set your User Identification (FCC Call Sign) and
Tactical Call for the assigned agency.

Check settings before transmitting:
Correct BBS in Outpost
Correct Interface in Qutpost
Correct radio frequency

Begin packet operations. Make ICS 214 Unit log entry.

38

Copyright© 2021 Santa Clara County ARES/RACES. All Rights Reserved.
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14.

15.

16.

17

3. Packet Operations
Packet Field Deployment Process

3. Packet Operations: Managing the message flow
12.
13.

Download all notices to ensure you have the latest; read them.

Set up a folder named “SCC Notices” (Tools > General Settings,
Startup tab) and move all notices to this folder.

Send a test message to yourself to confirm you can create, send
to, and receive from the assigned BBS.

Create a Check-In message to your assigned agency using your
Tactical call sign (see Section 5 Check-in, Check-out Message).
Send, receive, log and process packet messages. To only send a
message as soon as it is created, use Actions > Send Only
Manually initiate an Outpost Send/Receive at least every 10
minutes.

. If a message was not acknowledged:

a. Check the message address and BBS
b. Resend the message if needed
c. Letyour supervisor know

... more

3. Packet Operations (continued)
Packet Field Deployment Process

3. Packet Operations: Managing the message flow

K

19.
20.
21.
22.

If new notices are retrieved, follow any new instructions.
Maintain voice radio contact on the designated voice net.
Make ICS 214 Unit log entries as appropriate.

Report any issues or problems to your supervisor in person or
over the voice net (if remote).

39

40

Copyright© 2021 Santa Clara County ARES/RACES. All Rights Reserved.
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NI

24.
25.
26.

2%

28.
29.

4. Incoming Shift Change
Packet Field Deployment Process

4. Incoming Shift Change: If you are relieving someone else, do the following:
23.

Inform Resource Net Control that you have arrived. Check out of
the Resource Net before you leave your car.

Sign in on the local ICS 211 Check-in sheet.
Find the supervisor and inform them of your arrival.

Request a safety and assignment briefing; get details on any site-
or event-specific conditions that exist.

Find the person you are relieving and receive a shift change
briefing (see Shift Change Information below).

Make packet system updates — Station ID, Tactical Call, etc.
Make all relevant shift change entries in your ICS 214 Unit log.

12/11/2021

41

5. Outgoing Shift Change

Packet Field Deployment Process

5. Outgoing Shift Change: If you are being relieved, do the following:

v
v

30

31.
32.

33.
34.

35.

36.
37.
38.

. When contacted by your replacement, provide a shift change
briefing (see Shift Change Information below).

Generate and sign a packet ICS 309 Comm Log for your shift.

Generate all event packet documentation for your shift and deliver
as instructed (see Section 8 Archiving Event Documentation).

Turn over all assigned equipment to your replacement.

Find your supervisor and inform them of the shift change and your
departure.

Make the appropriate shift change entries in your ICS 214 Unit
log. Complete and sign the form.

Turn in all paperwork to your supervisor.
Sign out on the site’s ICS 211 Check-in sheet.

Check into the Resource Net. Inform Net Control what you plan to
do (go home, return to EQC, etc.).

42
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T RS

41.
42.

43.
44,
45.
46.
47.

6. Securing Operations
Packet Field Deployment Process

6. Securing Operations: when directed to shut down, do the following:
39.
40.

Get permission from your supervisor to shut down.

Create a text Check-Out message to your assigned agency using
your Tactical Call sign (see Section 6 Check-in, Check-out
Message).

Generate and sign a packet ICS 309 Comm Log for your shift.
Generate all event packet documentation for your shift and deliver
as instructed (see Section 8 Archiving Event Documentation).
Complete and sign your ICS 214 Unit log.

Shut down and pack up all assigned equipment.

Turn in all paperwork to your supervisor.

Sign out on the site's ICS 211 Check-in sheet.

Check out of the assigned voice Net and check in with the
Resource Net. Inform Net Control what you plan to do or where
you will go.

Amateur Packet Radio

Field Reference (unofficial)

What is it

e Provides a reminder (job aid) for
how to perform tasks that need
to occur during a packet field
deployment.

e Helps ensure task consistency,
completeness, and operational
alignment with SCCo RACES
policies and procedures.

What it is not

¢ the only source of information on
which you should rely.

¢ an official SCCo RACES
deliverable.

(the unofficial)
Amateur Packet Radio
Field Reference

For SCCo RACES Responders

October 2021

@

b

43

44
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Table of Contents
1 QUICK REFERENCE

Amateur Packet Radio
Field Reference (unofficial)

}

2 INTRODUCTION

2.1 Pureost

2.2 How To USE THiS HANDBOOK ...
2.3 OtHer ReFERENC|

Where to find it...
https://bit.ly/PacketFieldRefFull (.pdf)... great

PACKET OPERATOR CHECKLIST.
PACKET STARTUP PROCEDURE.......
CLIENT SOFTWARE

STANDARD SUBJECT LINE FORMAT
CHECK-IN, CHECK-OUT MESSAGE...
RECOMMENDED FORM ROUTING CHi
ARCHIVING EVENT DOCUMENTATIO!

R

10 MANUAL PACKET

9.1  Create THE ICS 309 CommunicaTion Log.
9.2 CREATE A PRINTABLE LIST OF YOUR MESSAGES
9.3 CREATE AN ARCHIVE OF YOUR MESSAGES .....
9.4  ReseT (cLeanup) OUTPOST FOR THE NEXT EVENT

101 TNCC

10.2 BBSC

10.6  Senoing PackltForms

10.3  CoMMECTING TOYOUR TNC..ooovunrinerainenens
10.4  StarT of SHiIFT: ConFIGURE TNC SETTINGS
10.5  Enp or SHIFT: ResTore TNC SETTINGS.......

10.7 _ Receving PackiTForms

for storing on your laptop or tablet.
https://bit.ly/PacketFieldRefBooklet (.pdf)...
formatted to create an % size booklet; just
print, fold, and staple in the middle.

Or contact kn6pe@arrl.net

12/11/2021
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What's the plan for 20227

e Maintenance release planned

— Fix reported bugs; Outpost enhancements, PackltForm enhancements

® Pop-up Packet Exercise
- 30-Apr-2022
— 8-Oct-2022

e Packet class schedule
— Packet Type lllA  6-Aug-2022
— Packet Type llIB 1-Oct-2022
— Packet Type Il 5-Nov-2022

Copyright © 2021 Santa Clara County ARES®/RACES. All rights reserved.

And, new class content, such as...

46
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12/11/2021

A look at DIY KPC-3 alignment

e Ensuring your TNC-Radio is properly
set is critical to packet operations.

¢ This includes both Receive Volume
and Transmit Level.

e The KPC-3x Manuals are good at
describing what to do but lack an
end to end description of exactly how this is to be done.

e Being able to make these settings is critical to Packet field
operations.

A look at DIY KPC-3 alignment

¢ Setting the Transmit level — you will need:

The latest KPC-3x manual for reference.
A KPC-3x to calibrate.
An HT to receive the transmitted CAL signals.

A dummy load (While not required, it is always
good not to splatter your calibration tones all
over the airwaves).

A smartphone app such as Decibel X g
to display the audio.

e Watch for a details in 2022 on a DIY
approach to setting the transmit level.

47 48
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For More Information

e Support

— See the Santa Clara County ARES/RACES web site packet page
e https://www.scc-ares-races.org/data/packet/index.html

— Join the packet discussion group
e Practice

— Send a message during the weekly packet net, either or both days
e https://www.scc-ares-races.org/data/packet/weekly-packet-practice.html

12/11/2021

¢ Automated feedback to help you improve, verify you’ve got it right

— Participate as a packet operator at drills and other events

49

Countywide Drill and SET
October 09, 2021

Andreas Ott, K6OTT
Revised 11-Dec-2021

50
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12/11/2021

Drill Summary

* Deployment Drill Exercise, minimal info was given
to participants

* Travel to location and set up, be prepared to
operate and conquer the unknowns

* “Dress Rehearsal” before incident deployment

* Same location as 2019 with activities FieldOps,
NetControl, PacketOps and Shadowing

More drill stats

Day of drill: ~ 250 person hours on ICS-211
Preparation: estimated ~ 300 person hours
Post-processing of paperwork and evals: 100 hours
Ratio of participants to staff is only 3:1

51 52
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12/11/2021

Drill Feedback

* Packet messaging throughput outpaced voice
about 8:1! Thank you, Mark!

* We will use more Outpost scripting in the future
* Quality of submitted documents is going up

* Timing of shifts and spacing of exercises (MSEL)
* Equipment problems at netcontrol (radio trailer)

* Intermod (frequencies) and fundamental overload
(radio hardware quality)

* Evaluations at drills: delays and problems removed
required activities, evaluators in double-duty roles

Preliminary ARRL SET report 2021

* 42 participants (incl. 1 visitor, 1 remote)

e Of these were 13 new hams, licensed 2017 or later
* 2 message nets, command net, packet + voice net
* 25 voice messages (?), 198 packet messages (!)

* 17 "agencies” EOCs, shelters, rovers, packet

* 12 “jurisdictions” Xanadu plus participating cities

* All stations on emergency power

* At least 723 points total, maybe some more

53 54
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12/11/2021

October Communications Drill
and SET

Packet Operations Observations

Mark Laubach, K6FJC
Revised 24-Nov-2021

Packet Operations Summary

e 2 shifts, 7+ 5 = 12 simulated shelters

* Automated EOC Outpost Script drove messaging passing
Task Groups

* 2 P2 evaluations, 8 P3 evaluations conducted

* 193 messages passed (not including Delivered receipts)

* Time performance overview (in minutes) highly variable:

M1 12 13 14 15 16 17 21 22 23 24 26
ek ele  00:57 01:14 00:43 01:34* 00:28 00:19 01:05 00:43 00:45 00:57 00:37 00:16

from shift start
Immediate
received from
Check-in
Check-Out delta
from Check-in
Check-Out delta
from shift start

00:36 00:17 00:49 00:32 00:11 00:26 00:39 00:39 00:29 00:31
01:28 00:35* 01:20 01:52 00:57 01:25 01:32 01:42 02:36 01:45

02:11 02:09 01:48 02:11 02:02 02:08 02:17 02:39 03:13 02:01

* First check-in message was sent at 0:34, but not properly formatted

55
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Packet Operations Future Drill Considerations

¢ Increase training/emphasis on pre-event preparation
— Each participant needs to understand their set-up time for time mgmt
— Also, hopefully can reduce set-up time

¢ Expect some “checklist education” on pre-operation readiness
— What needs to be done before Check-In

¢ When the exercise follows a “deployment” scenario:
— Defining a “shift” for packet didn’t work out as expected
¢ Highly variable set up times
¢ Management was not practicing “good” time management
— Expect an “operational period” to be defined within a Shift
¢ Model a served agency’s operational period requirements

o Packet stations must be ready to go with Check-in at the start and will be
closed down at the end

e Each participant will need to plan accordingly lead-time and tear down

12/11/2021

57

Monthly Packet Message Passing Practice

e The Outpost script-driven messaging passing automation
worked well during the October exercise

e We are going to trial a monthly packet message passing
practice on December 15t%. Starts at 09:00 on Wednesday the
15th and ends on 17:00 on Wednesday the 22"

— Zoom “office hours” on the evening of Wednesday the 22,
e Participants will need to sign up for the SCC Event

— Those that sign up will be assigned a tactical ID and ICS location
e This first trial will be a modified re-run of the SCCo exercise

Message passing task group from 9 October
* Intent is to exercise 3" party and operator-to-operator

messages following a different scenario each month

— Keep it interesting and non “cut and paste”

58
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12/11/2021

Net Control Training for 2022

Type lll Part A& B
Type ll

Mark Laubach, K6FJC
Revised 24-Nov-2021

Plans for 2022

e Continued emphasis on pre-class homework
— Expect updated course materials one week before class
— Homework will likely be moved to a separate handout / presentation
e Type lll Part A
— Add focus on pre-assignment readiness and planning
— May include a new checklist or two...
e TypelllPartB
— Focus will remain on operating, but some added emphasis on process
flow (hint: checklist)
e Typell
— Rebalance of homework versus class material
— Will try to develop additional class participation exercise(s)

59 60
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12/11/2021

Message Passing

Tim Howard, KE6TIM
Revised 04-Dec-2021

Class Changes

Added a homework component to class with a review

during the first part of the class using message samples:

http://bit.ly/Med-Base
https://www.pge.com/en_US/safety/

The P/N is 5bcDEw

Meet at 37° 22’ 13.97” N, 122° 02’ 24.56” W
ICP located at 37 22.2328, 122 02.4093
107AE 1st St Apt 3C

o O O O O O

Added Unknown Symbol/Character

Added Superscript/Subscript

Clarified other procedures to eliminate confusion and
ambiguity

61 62
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* Message Handling Procedures
were updated based on:

o Observations during drills,
events, and credential
evaluations

o Feedback from this years
two Message Passing
Classes

o Discussions with our
message passing team.

Santa Clara County ARES®/RACES

Message Handling

Procedures

Revised: 19-November-2021

12/11/2021

63

Unknown Symbol or Character

e Example:
- Written: Send 50 Z today
- Spoken: “send FIGURES fife zero <pause> UNKNOWN SYMBOL
<pause> today”

The receiver draws an empty box on their message form where the
unknown symbol would appear.

send 50 today

e Example:
o Written: We can use ab§6 instead
o Spoken: “We can use MIXED GROUP alpha bravo UNKNOWN
SYMBOL UNKNOWN SYMBOL <pause> instead”

We can use ab[[] instead

64
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SUBSCRIPT and SUPERSCRIPT

Used to indicate the following character should be written a half-line
lower (SUBSCRIPT) or higher (SUPERSCRIPT) than the rest of the text,
such as subscripts and mathematical exponents

Used with one character at a time

Does NOT remain in effect until the end of the group

* Examples:
- Written: White blood cell count is 10°

- Spoken: “white blood cell count is FIGURES one zero
SUPERSCRIPT fife”

o Written: Model XS4,

- Spoken: “model MIXED GROUP x-ray sierra four SUBSCRIPT six
SUBSCRIPT tree”

12/11/2021

65

SUBSCRIPT and SUPERSCRIPT

¢ When given a chemical symbol to send, if possible, ask the message
author to provide the common English word for the chemical.
If that is not possible, then use the procedure outlined above.

* Written by message author: H,0,

Corrected by message author:+585 Hydrogen Peroxide

¢ Spoken: hydrogen peroxide (you might use | SPELL here to ensure
precise copy

66
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12/11/2021

(¢]

(0]
(6]
(¢]
(0]
(0]

MWHAHS)

Identifies one or more letters to follow
* Used for non-word letter groups
* Voice each letter phonetically
* Leave a pause after the last letter to help separate it from groups
that follow
* Use for letter groups such as Initials, Abbreviations and Acronyms
* |Isimmediately followed by white space or a punctuation mark .,

* These are Initials

ARRL

St.

Dr.

EOC

CA

T. (AsinJames T. Kirk)

1 ?
HL

HGURHS)

Identifies one or more numerals to follow
* Voice each digit separately
* If anything, other than a numeral is present, it becomes a

MIXED GROUP, MIXED GROUP FIGURE(S), or MIXED GROUP SYMBOL(S).

* These are Figures

(¢]
(¢]
(¢]

145
35
13253

* These are NOT

o

O O O O

-145 (Mixed Group Symbol)

13,253 (Mixed Group Figures)

2/3 (Mixed Group Figure)

146.595 (Mixed Group Figures)

408.555.1212 or 408-555-1212 (Telephone Figures)

67

68
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Symbols

Some symbols have context sensitive names

12/11/2021

B B

decimal (in numbers), or & ampersand < less-than-sign
dot (in email, packet, and = reater-than-sign
. internet addresses), or *  asterisk 21 &
period (end of sentence and / slash underscore
elsewhere) -
\ | vertical-line
- comma
7 ., seconds (in GPS coordinates), A caret|careet |
colon
double-quote (e/sewhere) ~ tilde | till dee |
;  semi-colon apostrophe (within a word), -
t « minutes (in GPS coordinates), ° P
?  gquestion-mark =
H uestion ma or single-quote (elsewhere) degee sy o)
1 exclamation-point -
o Voicings are shown in bold.
minus-sign (in numbers, ei,
= hyphen (7,,, |€lora‘s) or i % percent-sign Voice hyphenated words as if they
dash (elsewhere) ( left-parenthesis are a single-word.
+ plus-sign ) right-parenthesis Punctuation symbol voicings are
underiined.
= equal-sign [ it sduarebracket Contextis shown in talics.
@] | atslkn: 11 [ feht-squsre braciat \ Pronunciation \ is between
# pound-sign { left-curly-bracket backslashes.
$  dollar-sign } right-curly-bracket

69

Recommended
Field Groupings

o Msg Nbr, Date, Time, Handing
To, From

Report Type, Shelter Name
Then go section by section
Say section name

Say field name(s) and value(s)
Shoot for about 5 items
(fields/groups) at a time

Skip empty fields & sections

oo o000

o

See examples of the
other forms in Appendix A
of the Message Handling

Procedures document

Santa Clara OA Shelter Status

Radio Opsrator Only: | Origin Msg #:

| Destination Msg i:

WRBLOC: 20130814
POF: 190619

s i P i
Date: Time (2h): Laodliog:
¢S Position:

T | tocation:

O | Hame:
|| contactinto:

e

Shelter O Report Type=Complete

(PiekOne)  OTypal Ortype2 Orype2 Orypea
Pesom)_OOpan ey Ollossdsen_ Ol

2ip:

Latitude (d 664y [ Longitude (4.464'):

Shelter Information 1 Report Typm=tomlete.
Capasity;

Oscupancy:

Meals Served (Last 24 hours):

1SS Number:

Pat Friandly: Oves One

Basic Safety Inspection: Oves Ono

ATC-20 Inspection: Oves ONo

Available Services:

MOU [where/how sent):

Flaorplan [where/how sent}:

70
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APPENDIX B - Summary of Prowords used in Message Passing

Control Prowords

Define the start, end, or control the flow of the message.
MESSAGE NUMBER

BREAK

STAND BY

CONTINUE or GO

NEWLINE

END OF MESSAGE or MESSAGE ENDS
SAY AGAIN or SPELL (PHONETICALLY)

Clarification Prowords

‘Always spoken AFTER a group. Clarifies or emphasizes what was just said .
1SPELL
| SAY AGAIN

Qualification prowords

Always spoken WITHIN a group. Defines a quality to allow precise copy.
UPPERCASE and LOWERCASE
SUBSCRIPT and SUPERSCRIPT

Introductory Prowords

Always spoken BEFORE a group. Alerts h
INITIAL(S)
FIGURE(S)
SYMBOL(S)

) FIGURE(S), (s)
‘TELEPHONE FIGURES.

GPS COORDIANTES

AMATEUR CALL

EMAIL ADDRESS

PACKET ADDRESS

INTERNET ADDRESS

Itis important to use each proword in the right place (before, inside, or after a group) to
avoid confusing the receiving station and slowing down the message transfer.

Form Updates

ICS 214 and ICS 309
revised to add a
signature block

UNIT LOG [f

1cs 214-5CCo

ARESRACES JFrom:
- ont e o i o8 Postony
- Porsonnel Rostor Assigned

e Calsin
o ACTVITY LOG
:‘r... ) o Ao S B ThoTwegp Mg oy
£ o
‘ ‘ ) Page of.

1CS 2145CCo ARES/RACES (rov. W

COMM Log 2

c8 308-5CCo

aces From: To:
5 COMMUNICATIONS LOG

Time From o

Mossage
P T T )
| —
7
. Propard B D, o Sin) on sgmare P
Page___of

1GS 303-50C0 ARESIRACES (Rev. 2021-Apr-08)

72
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SCCo BBS System update

Andreas Ott, K6OTT
Revised 11-Dec-2021

Accomplished in 2021

Slowly emerging from Pandemic restrictions: we
were able to access field sites during second half of
year

Replaced 3 of 4 BBS computers with new
hardware, virtualized BBS servers, backups

Monitoring of network and power status

Minor device and component maintenance,
software upgrades

73 74
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12/11/2021

Plans for 2022

* Finish hardware replacement of BBS computers
* Plan for firewall replacement

* Add subscriber stations (at EOCs, hospitals)

* Plan for County EOC relocation ~2024

* Software improvements (servers and JNOS) — Big
Thanks to Thomas KK6FPP and John W6JMK

* Possible automation of Practice Packet NetControl

Changes to FCC

Station Evaluation Rules

Yes, you need to do an
RF Safety Evaluation

Andreas Ott, K6OTT
Revised 11-Dec-2021

Acknowledgement: Morris Jones, AD6ZH

75 76
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12/11/2021

Before

RF Safety Evaluation

License requires evaluation
FCC Bulletin OET 65
Appendix B is written
specifically for hams

Keep human exposure b

specified levels (244’%d
Table shows vatdation

is required 6“

Powerkvefincludes both
transmitter power and
isotropic gain of antenna
— Dipole => 2.15dBi

Band |Power| Band |Power
160m [SO0W| #m |50 W
80 0"| 2m |sow
00 |1.25m|50W
ﬁo 425 | 70cm | 70 W
20 225 33 150
17 125 23 200
15 100 13 250
12 75
10m |50 W

47

Before

From OET Bulletin 65 Appendix B...

s VHF/UHF - Less than 50 watts radiated, no evaluation needed

« Safe exposure distance from the antenna for 50
transmitter and different antennas from Byllegin 65 (worst
case), watch for magmount on top of car@§0 Watts

X | (dBi)

(feet)

1442m) 3 10.6

6 14.9

222(1.25m) 3 10.6
6 14.9

450 (70cm) 3 8.6
| s 122

77

78
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12/11/2021

FCC Rule and Order 19-126
Effective May 2021

* From ARRL ARLBO11:

The new rules do not change existing RF exposure (RFE) limits but do require that
stations in all services, including amateur radio, be evaluated against existing limits,
unless they are exempted. For stations already in place, that evaluation must be
completed by May 3, 2023. After May 3 of this year, any new station, or any
existing station modified in a way that's likely to change its RFE profile - such as
different antenna or placement or greater power - will need to conduct an
evaluation by the date of activation or change.

e https://docs.fcc.gov/public/attachments/FCC-19-126A1.pdf
(159 pages, contains submitted comments, and math)

But how?
ARRL web pages (info, FAQ, calculator)

http://www.arrl.org/rf-exposure
http://www.arrl.org/rf-exposure-calculator
QST article September 2021, pp. 60-62

To get proof of evaluation: do it on ARRL web
calculator, and then print to PDF and save file

Controlled and uncontrolled exposure (have
different maximum permissible exposure limits),
you want to note the two distances for your setup

79 80
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And why would you care?

* RF energy gets absorbed into your body. It heats

up tissue over time, and the more you transmit. It’s
accumulative, unless you let your tissue cool down
in between transmissions (duty cycle).

Human body is most susceptible to 30-300 MHz

Controlled (your and your household) versus
uncontrolled exposure (bystanders) have different
maximum permissible exposure limits.

12/11/2021

81

For which stations?

* All stations! The way | read the R&O, this applies to

your home station or your EOC, and you have until
May 2023 to comply if you have had that station
without changes since before May 2021, but it also
applies to stations we (temporarily) set up in the
field for drills and exercises, and after you make a
change to any station.

82
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12/11/2021

So, what are the new safe
distances?

* |t depends, they are the same as the old safe
distances, but no more easy tables for lookup, and
you will be surprised by what “used to be safe”

e Calculation is somewhat involved, as the rules are
based on field strength and power density, two
parameters not easily accessible; and dependent
on the transmit frequency

* Variables to be filled in: transmitter power,
feedline loss, antenna gain/loss, frequency,
emission mode and transmitting duty cycle

Easy to understand principles

Use low(er) power, as you should anyway

Keep radio antenna away from body when feasible,
or keep body away from radio antenna (heh)

Let body cool down, exponential decay, take
breaks in between transmissions (lower duty cycle)

Keep transmissions short, efficiency as a goal

Check common use cases: body-worn radio,
magmount antenna on car roof, pushup mast

Use conservative defaults as input

83
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12/11/2021

Auxiliary documents

* Radio, antenna and feedline datasheets
* The ARRL calculator has a references, also to the
math and code they use

* The former OET Bulletin 65 and Supplements have
not been updated since the R&O became the law
and are Sti” ”U nder reVieW" https://www.fcc.gov/general/oet-bulletins-line

[noTiCE]
(0-‘0)

ACAUTION

[anancer

Radio frequency fields beyand
Fec

Gboy all pasted signs and site guidelines

‘Beyond this point:
Radio frequency fiokds at this site
may exceod FCC rules for human
exposure.

Bayond this point:
Radio trequancy fields st this site
may exceed FCC rules for human
axposure.

emvironmants.

ing in radia
Hroquency environments.

ubdelines for working in radic frequency

Bayond this point:
Radio fraquoncy fields at this site
may exc human
axposu

Failurs 1o and site
kel for werkvg in radls reuescy

Copyright © 2021 San|
Al

ARES®/RACES,
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12/11/2021

Live dmo of ARRL calculator

EC Reports

2021 Volunteer Hours

Andreas Ott, K6OTT
Revised 11-Dec-2021

87 88
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Overview 2021 Data entry
. y EC Report i for the Year 2021

* First 7 months:

89 reports e R R S rsrr * Thank you for submitting reports and “activating
oty o S G 444 hours to be counted

L4 . si:;ﬂm ° D J p . o

4 recent months'm.ws ~ » We will backfill data Jan-Jul 2021 by January, so

Loma Prieta ?» O O Q .

66 reports s old § g é 2 o that a full report will come out of the new system
" report 5 5 58 9 * Please be patient and do not enter old data on
oo v system |5 093 your own, but go back and check (update?) when
b 20000 we tell you that it’s ready
San Jose 0990000
Santa Clara City Q000 0O
Saratoga 00000
Stanford University Q0000
Sunnyvale Q0 000

89 90
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Preliminary stats 2021

e Jan—Jul 2021: approx. 8,133 hours

* Aug— Nov 2021: approx. 5,264 hours

* Dec 2021 estimate: 1,100 hours

* Year 2021 summary: approx. 14,500 hours *

(Yes, there were more activities since July after
restrictions were lifted, but we also think we are
captioning more hours and more accurately through
better reporting.)

* The equivalent of $ 2.175 M at minimum wage

2022 Training

Judy Halchin, KKGBEWQ
Revised 3-Dec-2021

91 92
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2021 Review 2022 — What to expect

* Another good year for Gumby

All the regular classes were offered

Watch your email and the sign-up
pages
Full slate of classes scheduled

Zoom-to-classroom transition
* Plenty of masks and plenty of space

* Largest classes stayed on Zoom

Packet practice and mini-drill = April 30

Field Operations classes over the air

Annual drill September 17 — mark your
calendar

Online class evaluation forms

93 94
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Credentials

Tim Howard, KE6TIM
Revised 30-Nov-2021

Clarification of Requirements

To earn a Credential, participation in Training Classes, Exercises,
and Public Services events must be completed within two years.

Participation in Exercises and Public Service events can not be used
for more than one credential. For example: if a Public Service event
is used for your C4, it can not also be used for an F3 Credential. A
different Public Service event is required.

Participation in an activity must be in the same role as the
credential it is being applied to. For example: if you are working on
a P3 Credential, the duties you performed at the activity must be
packet-related. Working as a Field Operator will not satisfy the
requirements for a Packet P3 Credential.

Participation must be at a credential-approved activity.

95 96

Copyright© 2021 Santa Clara County ARES/RACES. All Rights Reserved.

48



2021 Year End Summary
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Clarification of Requirements

e Equipment checks are good for one-year. For example: if you
completed an F3 equipment check, you can use that for an N3
within one year and do not need to repeat the equipment check.

¢ Where equipment requirements are different, you would only need
to have the additional equipment checked.
* Radio familiarity and Knowledge tests are also valid for one year.

* Again, where requirements are different, only the additional
requirements would need to be done.

Clarification of Requirements

¢ To maintain Credentials, you must
o Take partin two credential-qualified activities (exercises,
events, incidents) within each two-year period
o Or take partin one credential-qualified activity and at least one
“End of Year Summary’ class within a two-year period.

* Failure to do so will result in loss of Credentials. We made an
exception for 2020 but will be looking at participation again moving
forward.

* There is a reinstatement process outlined in the “Credential
Program Handbook” that can occur within two years of losing a
Credential.

97 98
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12/11/2021

COVID - Credential Requirement Extension

2021 2022 | 2023 |

2018 || 2019 || 2020 1 |

J[FMAM 12T s[e[N ][ FIMAM A [2]AlsTo[N[D| [FM AlM 2 sTaTs[o[N[ o] s TF[MAIM T2 TaTs[o[ Mo [FMAM 1] s TATsTo[N[o] : TFMAM 2 [ ]A
Shut Down| COVID SHUT DOWN (16 months)
Example 1 | Two year period 1]
Example 2 | Two year period | 7 month ext.
Example 3 [ Two year period ] 13 month extension
Example 2 [ Two year period 16 month extension
Example 5. I Two year period 16 month extension

First canceled class was March 7, 2020
First canceled drill was March 21, 2020
First canceled public service event was April 25, 2020

Activities (Drills, Training, Public Service) resumed July 1, 2021

Q&A

All Training Staff
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Thank You!

Please check your email and follow the instructions to
complete and return the Course Evaluation.

If you have questions or feedback about this or other training
activities, you can join our Training discussion group.
https://scc-ares-races.groups.io/g/training
This is a moderated group.

See you at a training class or exercise next year!
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